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Adding New Worksheets to a File 

 
Although Excel for Windows always start up with 3 worksheets per file, 
you can create additional worksheets depending on how much memory 
your computer has.  When multiple worksheets are in memory you can 
work with any one of them or with several at the same time, and move 
between them much like flipping through pages in a notebook.  Excel 
assigns Sheet # to worksheets.  When you insert a worksheet in a file or 
delete one, Excel adjusts the sheet numbers accordingly. 
 
Inserting new worksheets is like setting up separate pages to hold 
different but related information.  It is useful for data querying i.e., the 
answer to your query always appears on another worksheet within the 
current worksheet. 
 
By default Excel inserts 3 sheets in a new workbook.  You can change 
the default number through Tools, Options, General. 

Inserting Sheets 
 
To insert a new worksheet after the current worksheet 

1. Click on the Sheet tab with your right mouse button. 

2. Displays shortcut menu.   Choose Insert 
 

 

3. Select Worksheet and choose OK 
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Naming Worksheets 
 
A worksheet can be named by double-clicking the Tab and typing a more 
meaningful name of up to 31 characters. 

Selecting Sheets 
 

Selecting a Single Sheet   Click the Sheet tab 

Selecting a group of  sheets Select the first sheet in the 
range hold shift and click on 
the last sheet in the range 

Selecting odd sheets Hold Control and click each 
sheet tab 

 

Deleting Worksheets 
 

1. Click on Sheet tab to delete 

2. Display shortcut menu.  Choose Delete 

3. OK 

Moving Worksheets 
 

 Click on the worksheet tab and drag to another position, release the 
button 

Copying a Worksheet 
 

1. Hold down Control and select sheet tab 
 
2. Drag to a new location 

Moving a Sheet into another Workbook 
 
1. Select the sheet or sheets to move 

2. Edit, Move or Copy sheet 

3. Select the destination Workbook and where you want your sheets placed. 

4. To copy the sheet into another workbook select the Create a Copy check 
box. 

 
Alternatively: 

1. Create a new blank workbook 

2. View both workbooks on screen: Window, Arrange, Tiled (See Page 7) 

3. Click the worksheet tab to move and drag to the blank workbook window. 
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Cursor Movements between 
Windows/Worksheets 
 

Control Page Dn Moves to Previous Sheet 
Control Page Up Moves to Next Sheet 
 

Formatting Worksheets Simultaneously 
 
Sometimes you want all the worksheets in a file to look the same, that is 
column widths, global formatting etc.  This is achieved by selecting the 
worksheet tab to work within a Group.  If you widen a column or format a 
range in one sheet in the group, Excel duplicates that change in all the 
other selected sheets. 
 

 Select a number of worksheets 
 
 The tabs of the selected sheet will appear white and [Group] appears in 
the title bar. 
 
Any formatting changes you now make will affect all the worksheets until 
you turn the selection off by clicking on another sheet tab. 
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Copying Between Worksheets 
 
Before you can start copying between worksheets, they must be inserted.  
Copying to one worksheet is as simple as normal copy, you simply move 
the cursor or type the address.  We will look at a three-dimensional range 
one that spans two or more consecutive worksheets in the same file.  
Whenever you are working with a multiple file, you can use three 
dimensional ranges in commands and formulas. 
 

Selecting a 3D Range 
 
A range that includes the same cells in two or more worksheets is called 
a 3D range.  The address of a 3D range includes the worksheet letters in 
the cell addresses; for example, the address Sheet2:Sheet4!A1:F20 tells 
you that the range A1:F20 is selected in worksheets 2 through to 4. 

 
1. Select the range in the first worksheet of the 3D range. 

2. Hold down Shift and click the worksheet tab of the last worksheet you 
want to include in the range. 

 

AutoSum through Worksheets 
 

1. Click on the cell to contain the formula 

2. Type the following; =SUM( 

3. Click on the tab of the sheet where the sum is to commence. 

4. Click the cell, which contains the value to sum. 

5. Hold down the Shift key and click on the tab of the last sheet in the 
group. 

6. Press <Enter>. 

7. Your formula will look similar to this:  =SUM(SHEET2:SHEET4!B4) 
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Copying Across Worksheets 
 
Copies the contents of the first worksheet in the selection to fill the entire 
selection. 

1. Mark the range you wish to copy i.e. Sheet1:Sheet4!A1:F17 

2. Edit, Fill, Across Worksheets 

3. Sheets 2, 3 & 4 now contain copies of worksheet Sheet1. 

 

Printing Data from Multiple Worksheets 
 

1. Choose File Print 
 

 

2. Select Entire Workbook 

3. Choose OK 
 
Note: Every worksheet that contains data requires memory.  If you 
need more memory, condense your data into fewer worksheets. 
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Working with a Group of Files 

Saving a Workspace 
 
If you often use the same group of files, you can save time by saving 
these documents together as a workspace.  Then whenever you need to 
call up all the documents at once you open the workspace. 

First open all the files you wish to save together and close any blank files 
or files that you do not wish to be in the workspace. 

1. File,  Save Workspace The Save As dialog box appears 

2. Type a filename for the workspace 

 Notice that Excel assigns the extension of .XLW to the workspace 
file, to help you identify them later. 

3. OK 

4. Close the documents  If any changes have been made Excel asks if 
you wish to save each file. 

5. To close all files at the same time hold down Shift and choose File, 
Close All 

 

Opening a Workspace 
Now whenever you need to open all the relevant files you can do so in 
one operation. 

1. File, Open Displays a list of files 

2. Highlight the workspace file - it ends with .XLW 

3. All files are loaded in one operation.   

There is no way at this stage that you can tell you have got more than 
one document open.  All of the open document windows are stacked up 
on top of each other, in a similar way to a pile of papers on your desk.  
You cannot read any other documents in the pile unless you move them 
to the top, or spread them out on your desk.  You can do exactly this 
using the commands on the Window menu. 

4. Window Displays all the active files 
 

Note: When you open a workspace the workbooks are opened just as 
you saved them. 
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Moving between open documents 
 
The Window menu is used to move between open documents, because 
each document is held in its own window. 

To view a list of the open documents, drop the Window menu down.  All 
open documents are listed on the bottom of the window menu.  There is a 
tick next to the document that is currently the active document. 

To move to another document, just click on the document name, and that 
document will become active.   

You can move through the open documents using the keyboard by 
pressing CTRL+F6.  This is called ñcyclingò through the open windows. 
 

Viewing all open documents simultaneously  
 
Using the Arrange command it is possible to see all open documents on 
the screen at the same time. 
 

1. Choose Arrange from the Window menu 

2. Select Tiled and click on OK  
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The picture below shows 4 open documents that have been organised 
using the Arrange command. 
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Range Names 

Naming Cells and Areas 
 
Cell ranges are normally referred to by their cell address, e.g. A1:A10 or 
S36:W50. However, Microsoft Excel allows you to assign names to 
individual cells and ranges of cells. This has three advantages: 

 Worksheets are easier to interpret as names are used in formulae instead 
of cell addresses; 

 Navigation about the worksheet is quicker and easier; 

 Named ranges are automatically absolute when used in formulae. When 
you copy a formula that uses a named range the range does not change 
when it is copied, unlike a relative range that does change when it is 
copied.  

Naming a Cell or Range of Cells 

 
First select the required cell or range of cells and then choose 
Insert|Name|Define from the main menu. You will then see the following 
dialog box: 

 

Type in the name that you want to assign to the selected cell and click on 
the OK button. This name will now be stored permanently with the 
workbook and will refer to the cell. 

 
Alternatively: 

 
1. Select the range of cells to be named 

2. Click inside the Name box on the Formula Bar 
 

 
 

3. Type Sales <Enter> 
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Creating a Named Range 

 
You can get Excel to do some of the hard work for you by creating the 
range names based on the headings in the columns or rows of the 
worksheet.   

In the example below we have selected the text in column A and the 
corresponding numbers in column B.  When you go to the Insert menu 
and choose Name and then Create the Create Names dialog box 
appears.  Choose the tick box that represents the position of the text you 
want to use as your names and choose OK.  Excel names all the ranges 
for you!  

 
 

Using a Range Name  

Worksheet navigation 

 
If you have named any cells, you can use the names for quick worksheet 
navigation by using the F5 GoTo function. When you press F5 the 
following dialog box is displayed. Any range names you have assigned 
will be displayed in the list. By simply double-clicking on the name you 
require, your active cell will become the first cell in the named range. 

You can also select named ranges by using the Name box at the left end 
of the formula bar. Click on the drop-down arrow to the right of the name 
box and choose the name you require. The range will now be highlighted. 

 

  
 
Using the down arrow on the name box 
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In formulae 

 
To use a range name in a formula, build the formula in the normal way; 
however, instead of clicking on the cells that will make up the formula, 
type in the name of the range to be used. Microsoft Excel will accept any 
valid range name into a formula and will still carry out all calculations 
correctly. 

You can also add names to formulae by selecting from a list of available 
names; this has the benefit of ensuring accuracy when creating your 
formulae. To use this method begin your formula as normal. When you 
want to insert a name, press F3. You will see a list of the available 
names; choose the names you need in your formula and continue. 

Pasting Names in Functions 

 
Instead of typing the range name in a formula you can simply choose the 
name from the Name dropdown list. 

 
=MAX 

1. Position your cursor where the result is to appear 

2. =MAX( 

3. Choose Insert, Name Paste  (F3) 
 

 

4. Displays the available names. 

5. Highlight SALES <OK> 

6. <Enter>  Enters the result in the worksheet. 
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Applying names 
 
When you create or define names, they are not automatically distributed 
to existing formulae on the worksheet. In this case you need to apply the 
name. 

First make your selection. If you choose a single cell anywhere on the 
sheet, the names you choose will be applied to all cells, wherever they 
are located on the worksheet, that refer to the named cells in their 
formulae. If you select a range of cells, only those cells will have the 
range names applied to them. 

Having selected the cells, select Insert|Name|Apply from the main menu. 
Click on the range names you wish to apply to your selection, and then 
click on OK. Your formulae will now use cell names rather than cell 
locations. 

Assigning a Value to a Name 
 
A name can refer to a value rather than a cell or range location. This is 
useful where formulae in your application need to refer to constant 
values, e.g. discount rates, tax rates, dates, times, etc., but where you 
donôt want the constants displayed. 

To create a name that refers to the VAT rate choose any cell on the 
worksheet and select Insert|Name|Define from the main menu. Type in 
the name VAT in the name box and tab down to the Refers To box. Type 
in 17.5%. Click on the OK button. 

This name can now be used in any formula to calculate VAT. If the VAT 
rate were to alter, choose Insert|Name|Define and amend the value in the 
Refers To box. All formulae using the name will be updated and the new 
answers calculated. 

Workbook v. Worksheet Names 
 
When you create a name it will be available to all worksheets in the 
current workbook. If, however, you want a name to be available only to a 
specific sheet, you can create a sheet level name. To do this select the 
cells and then choose Insert|Name|Define from the main menu. Type in 
the name of the sheet you are working on followed by an exclamation 
mark; then type in the name of the range. 

For example, to create a named range called Sales, available only on the 
January worksheet, you would assign the name January!Sales. 
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Deleting Range Names 
 

1. Insert, Name, Define 

 

2. Highlight Range to Delete 

3. Click the Delete button  
 

Pasting a List of Names into the Worksheet  

You can create a table within the worksheet that lists the range names 
available. 

1. Select a cell away from the normal data.  The list will overwrite existing 
data. 

2. Press F3 

3. Paste List 

4. Creates a table of existing range names and their locations in the 
worksheet.   
 
Note: The list is inserted purely as text, so it does not automatically 
update.  If more range names are created you will need to run through 
this process again. 

 



 

 

© Senan Solutions  Page 15 

The following is worthy of note when creating Range Names: 
 

 Range Names can be up to 255 characters 

 If the active cell contains text, Excel proposes that text as the Name.  
Otherwise it will propose text in the cell to the left or above the active cell 
as the name. 

 Names can contain letters, digits, underlines and full stops.  However you 
cannot use spacebars. 

 Names can contain uppercase and lowercase letters. Microsoft Excel 
does not distinguish between uppercase and lowercase characters in 
names. For example, if you have created the name Sales and then create 
another name called SALES in the same workbook, the second name will 
replace the first one. 

 If you use a name you have already defined, the new definition replaces 
the old one. 

 Range Names are automatically assigned as Absolute cell addresses. 
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Protecting Worksheets and Cells 

Introduction 
 
Having created a workbook, perhaps containing a number of separate 
sheets all with formulae and formatting, you will probably want to apply a 
measure of protection to it to stop some cells being amended or deleted, 
either accidentally or deliberately. 
Microsoft Excel allows you to apply protection to the workbook, individual 
worksheets and component cells. 
By default all cells are locked, i.e. protected, once you have turned on the 
global sheet protection feature. 

Sheet Protection 

 
To turn on sheet protection, select Tools|Protection from the main menu. 
Select Protect Sheet... from the sub-menu to see the following dialog box: 
 

 
 
You can choose exactly what users of the worksheet can do by ticking 
extra boxes if required.  For example, if you are happy for users to format 
the worksheet, tick format cells, columns and rows.  If required you may 
enter a password, but you must remember this password if you want 
to subsequently make any changes to the worksheet or if you wish 
to unprotect it. 

Having set the sheet protection, you will now find that you are unable to 
change the contents of any cell. Nor will you be able to delete or insert 
rows or columns, cut or copy any ranges, or alter the sheet in any way. 
Whatever you try to do you will see the following dialog box: 
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Unlocking a range of cells 

 
Having applied worksheet protection, you will probably want to change 
individual cell protection to allow some cells to be changed, e.g. values 
added. To do this you need to unlock these cells. 

Before you are able to do anything further on the worksheet you will need 
to unprotect it.   

Select Tools|Protection from the main menu and then Unprotect Sheet...  

If you previously set a password you will now be prompted to enter it.   
When you click on OK or press Enter the worksheet will be unprotected 
once again.  Now select the range of cells that you wish to unlock - this 
could be a whole column  or row or it could be non-adjacent individual 
cells.  

Having made the selection, choose Format|Cells and then click on the 
Protection tab of the resultant dialog box.  

 

You may now remove the cross from the Locked check box and click on 
OK. 
You will now need to re-protect the worksheet. Having done this you will 
find that you can amend those cells that are unprotected but no others. 
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Hiding formulae in cells 

 
In addition to protecting the contents of cells, you can also hide from view 
any formulae that appear in cells. This means that although you can see 
the answer displayed in the cell itself, you cannot see how the cell is 
calculated. 

To do this, first select the required cells and then choose Format|Cells. 
Click in the Hidden check box on the Protection tab. Once you have 
applied sheet protection, you will find that no values show on the formula 
bar for the cells in question. 
 

Workbook Protection 

If you wish to, you can set protection on the whole workbook. This will 
prevent any changes to the way that the workbook is either displayed 
and/or structured. 
Select Tools|Protection|Protect Workbook. 

You will see a dialog box where you can choose either to protect the 
Windows or the Structure. You may also set a password if you require. 

 

 
Windows 
Protection 

If you choose to protect the workbookôs windows, you 
will not be able to move, resize, hide or close any of 
the windows on display when the protection was set. 
All of the relevant buttons on the windows are hidden. 
 

Structure 
Protection 

If you choose this option, you will not be able to add, 
delete, rename, move, hide or unhide sheets. 
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Saving a file with a password 

 
The final stage in protecting your data is to assign a password to the file 
when you save it. This will prevent any unauthorised person even 
opening the file without the necessary permission. 
 
Choose File|Save As from the main menu and then click the Tools button 
and then choose General Options.. You will see the following dialog box: 
 

 
 
 
Password to 
Open 

Type the password required to open the selected 
workbook file. You are prompted to confirm the 
password. You can assign passwords to workbooks 
saved as templates and add-in macro file formats, in 
addition to those saved in the Microsoft Excel file 
format when the protection was set. All of the relevant 
buttons on the windows are hidden. 
 

Password to 
modify 

Type the password required to save changes to the 
selected workbook under the same filename. You are 
prompted to confirm the password 
 

Read only 
recommended 

Displays a message requesting that users access the 
file as read-only. This message is displayed before the 
workbook is opened only if users have cleared the 
Read Only check box in the Open dialog box. The file 
remains read only even when it is saved under 
another name using the Save As command on the File 
menu. 
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Functions 

 
Microsoft Excel has an extensive library of over 220 functions.  When you 
are familiar with a function you often type it directly into the worksheet.  
As you start to type the function ScreenTips appear showing you all of the 
arguments for the function, along with a link to the Help topic for the 
function.  

ScreenTips for function arguments 
Type a function in a cell and a convenient ScreenTip appears showing all 
of the arguments for the function.  Click the name of the function to link 
directly to the help topic for that function.  
 

 
 

Expanded AutoSum functionality 

The practical functionality of AutoSum has been expanded to include a 
drop-down list of the most common functions.  For example, you can click 
Average from the list to calculate the average of a selected range.   

Choosing More Functions from the list will open the Insert Function dialog 
box. 
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Insert Function dialog box 
 
The Insert Function dialog box replaces the Paste Function feature in 
previous versions of Excel and it provides practical help on creating and 
understanding functions. 

 
 
To view the Insert Function dialog box: 

 Choose Insert Function from the Insert menu.  

 Choose More Functions from the AutoSum button 

 Click the Insert Function button on the Formula Bar.  
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Natural Language Queries 

A big improvement on previous versions of Excel is the search for a 
function box that you can type natural language queries into. 

Typing ñHow do I calculate payments on my mortgage?ò, into the box 
presents the functions PMT, IPMT, NPER.  

Clicking the down arrow to the right of ñOr select a categoryò will open a 
list of functions grouped by relevant category.  

 
 

Choosing the Function you want to use and clicking on OK will open a 
dialog box listing the arguments for the function you choose.  
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Date and Time Functions 
 
Excel contains a number of functions created specifically for you to use 
date and time information in your worksheets. These functions are often 
used to add the system date and time to an application, or to extract part 
of a date or time value entered in a cell. 
 

How Excel Records Dates & Times 

The basic unit of time in Excel is the day.  Each day is represented by a 
serial date value from 1 through to 2,958,465.  The base date, 
represented by the serial value of 1, is Sunday, January 1, 1900.  The 
maximum serial value, 2,958,465 represents December 31

st
, 9999.  

When you enter a valid date in your worksheet, Excel records the date as 
a serial value that represents the number of days between the base date 
and the specified date.  For example, 1 January 2004 is represented by 
the serial value 37,987, because there are 37,987days between the base 
date 1 January 1900 and 1 January 2004. 

The time of day is a decimal value that represents the portion of a day 
between its beginning ï 12:00 midnight ï and the specified time.  The 
time 12:00 noon, for example, is represented by the value 0.5, because 
the difference between midnight and noon is exactly half a day. 
By assigning serial values to days, hours, minutes and seconds, Excel 
enables you to perform sophisticated date and time arithmetic.    

NOW() 

This function displays the system date and time. The NOW function has 
no arguments but you must type the brackets for the function to work. 
The NOW function changes only when the workbook is recalculated. 

TODAY() 

This function displays the system date only. The TODAY function updates 
on a daily basis. 

WEEKDAY(value) 

The WEEKDAY function returns the day of the week for a specific date 
and takes the form: 

 =WEEKDAY(serial_number,return_type) 

The serial_number argument can be a cell reference that contains a date. 

The return_type argument is optional and determines the way the result is 
represented.  If return_type is 1 or omitted, the function returns a number 
from 1 through to 7 where 1 is Sunday and 7 is Saturday.  For more 
information see help. 

The function =WEEKDAY("25/12/2004") returns the value 7.  25/12/2004 
(Christmas Day) is on the 7

th
 day which is a Saturday. 
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The YEAR, MONTH and DAY Functions 

The YEAR, MONTH and DAY functions return the value of the year, 
month and day portions of a serial date/time value.  These functions take 
the form: 

=YEAR(serial_number)  =MONTH(serial_number)  
=DAY(serial_number) 

The serial_number argument can be a serial date value, a reference to a 
cell that contains a date function or a serial date value, or a date text 
enclosed in quotation marks. 

The result of these functions is the value of the corresponding part of the 
specified serial_number argument.  For example, if cell A1 contains the 
date 25/12/2004 the formula 

 
 =YEAR(A1)  returns the value 2004 
 =MONTH(A1)  returns the value 12 
 =DAY(A1)  returns the value 25. 
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Text Functions 
Excel contains a number of text functions whereby you can manipulate 
text in cells. These functions are particularly useful where data has been 
downloaded from a mainframe system or from another package in ASCII 
format. 

LOWER(text) 

This function converts text to lowercase. 

UPPER(text) 

This function converts text to uppercase. 

PROPER(text) 

This function converts the first letter of each word of text to uppercase 
and the remainder to lowercase. 

LEN(text) 

This function returns the number of characters in the specified text. 

MID(text,start_num,num_chars) 

This function displays part of the text, beginning at the character specified 
by the start_num argument and displaying the number specified in the 
num_chars argument. 

CONCATENATE(text1,text2...) 

This function joins several items of data to form one single string of text 

TEXT(value,format_text) 

This function converts a numeric value to text and displays it with the 
format specified in the second argument. This function is especially useful 
when combining a number with a text string, e.g. 

 
=ñMy salary is ñ&TEXT(A1,òÃ#,##0.00ò) 

 
where cell A1 contains the salary figure. 
 

EXACT(text1,text2)  

The EXACT function compares the text in two cells. It displays TRUE if 
the cell contents are exactly the same, or FALSE if they are not. The 
EXACT function is case-sensitive (that is, it sees capital letters as 
different from small letters), but it ignores formatting differences such as 
bold or italic.  
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Financial Functions 
Excel contains many financial functions that are useful for assisting in 
making business and personal decisions. There are functions that 
calculate depreciation of fixed assets, internal rates of return on 
investments and many more.  An example of the financial function =PMT 
appears below.  

PMT 

This function calculates the payments for a loan based on constant 
payments and interest.  This can be very handy for calculating the 
monthly payments due on a repayment mortgage.  

 

Rate is the interest rate per period. For example, if annual interest rate on 
your mortgage is 7%, this argument will be 7% divided by 12.   

Nper is the total number of payment periods.  For example, if you have a 
25 year mortgage, and pay your mortgage monthly this argument will be 
25 multiplied by 12.  

Pv Is the present value, meaning the amount of your loan at the moment.  

Fv is the future value or the amount your want your loan to be at the end 
of the payment period.  You normally want to have paid off your mortgage 
completely by the end of the 25 years so this is normally set to zero. . 

Type is the number 0 or 1 and indicates when payments are due. 
 
Example 

 
 
In the above example you are borrowing 100,000 at 7% interest over 25 
years.  
The formula is  =PMT(B2/12,B3*12,B1,0) 
B2/12 represents the annual interest rate divided by 12 to represent a 
monthly interest rate. 
B3*12 represents number of payments, which is monthly for 25 years.  
B1 represents the loan amount at the moment 
0 is the last argument and this is the value we want the mortgage to be at 
the end of the 25 year term.  
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ROUND, ROUNDDOWN and ROUNDUP 

The ROUND function rounds the number referred by its argument to a 
specified number of decimal places.  Round takes the form: 

 =ROUND(number,num_digits) 

The number argument can be a number, a reference to a cell that 
contains a number, or a formula that results in a number.  The num-digits 
argument determines how many digits will be rounded.  Specifying a 
negative num-digits argument rounds that number of places to the left of 
the decimal; specifying a num-digits of 0 rounds to the nearest whole 
number. 
 
Excel rounds digits less than 5 down and digits greater than or equal to 5 
up.  The following table shows examples of the round function. 
 

Entry Returns 

=ROUND(123.4567,-2) 100 

=ROUND(123.4567,-1) 120 

=ROUND(123.4567,0) 123 

=ROUND(123.4567,1) 123.5 

=ROUND(123.4567,2) 123.46 

=ROUND(123.4567,3) 123.457 

 
The ROUNDDOWN and ROUNDUP functions take the same form as 
ROUND.  As their names imply, they always round down or up. 
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Statistical and Mathematical Functions 
These groups of functions allow you to carry out various statistical 
analyses and also give you the ability to find the answers to extremely 
complicated mathematical problems. 

COMBIN (number, number_chosen) 

Returns the number of combinations for a given number of objects. Use 
COMBIN to determine the total possible number of groups for a given 
number of objects. 

Example 

Suppose you want to form a two-person team from eight candidates and 
you want to know how many possible teams can be formed.  

COMBIN(8, 2) equals 28 teams. 

PERMUT(number, number_chosen) 

This function returns the number of permutations for a given number of 
objects that can be selected from number objects. A permutation is any 
set or subset of objects or events where internal order is significant. 
Permutations are different than combinations, for which the internal order 
is not significant. Use this function for lottery-style probability calculations. 

Example 

Suppose you want to calculate the odds of selecting a winning lottery 
number. Each lottery number contains six number sets, each of which 
can be between 0 and 49, inclusive. The following function calculates the 
number of possible permutations. 

PERMUT(49,6) equals  10,068,347,520 

Lookup Functions 
Lookup functions provide a very easy way of looking for a value in a list or 
table and displaying some or all of the data relating to that value. There 
are three different types of LOOKUP function, LOOKUP, HLOOKUP and 
VLOOKUP.   

VLOOKUP & HLOOKUP 

The most common Lookup functions are VLOOKUP (for vertical lookup) 
and HLOOKUP (for horizontal lookup).  Both these functions look up a 
particular value or text entry in a table and return related information from 
the table.  They differ simply in the way they do their work: 
 
VLOOKUP  
The VLOOKUP function moves vertically down the rows of the lookup 
table, looking for matching information in the first column of the table, and 
will return the information from any column of the table.  
 
HLOOKUP  
The HLOOKUP function moves horizontally across the columns of the 
lookup table, looking for matching information in the top row of the table. 
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The following examples are explained using VLOOKUP.  The examples 
assume that you are using two sheets within a workbook.  One sheet is 
an invoice and in the other sheet is a list of the products you sell together 
with the Cost and Retail Price.  Whenever you type the item number of 
the item ordered into Column A of the invoice you want VLOOKUP to 
return the Price and Description of that item.  This will save you time as 
you will not have to lookup the price manually yourself. 
 
Invoice Worksheet 

 
 
Product List Worksheet 

 
 

Setting Up a Lookup Table 

In this example the sheet named ñProduct Listò contains the lookup table, 
meaning the information you are going to retrieve. When setting up a 
lookup table you always place the information you will use to lookup other 
information in the first (leftmost) column.  In this case, because you want 
to lookup the description and cost of an item by its item number, you 
make sure that the column containing the item number is the first column. 

Further, after entering all the information in the lookup table, you must 
sort the first column in ascending order.  Notice how the lookup table 
above is sorted by its item number, SP001 to SP009. 

After you have created and sorted the information in the lookup table, you 
can use the VLOOKUP function in the invoice worksheet to return any of 
the information from the lookup table in the Product List worksheet.   

The arguments for the VLOOKUP function are as follows: 

VLOOKUP(lookup_value,table_location,col_num,range_lookup) 

The lookup_value argument in this example is the cell in the invoice 
worksheet that contains the item number (SP001-SP009) you want 
looked up in the lookup table in the Retail Price and Cost Price 
Worksheet. 
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The table_location argument is the cell range that contains the lookup 
table itself, (excluding column headings).  In this example, the lookup 
table occupies the cell range A2:D10 in the Product List worksheet.  To 
make the lookup function easier to do and understand it is a good idea to 
give the table_array range of cells a range name.  In the following 
example they have been given the range name Price_Table. 

The col_index_num argument is the number of the column in the lookup 
table whose information you want returned by the VLOOKUP function.  
To get this number, count the columns in the lookup table from left to 
right, starting with 1.  For example, if you want the lookup table to return 
the description of the pie when you enter its item number, enter 2  as the 
col_index_num argument.   

The final argument determines whether the values are sorted in 
alphabetical or numerical order. If you type TRUE or the argument is 
omitted, the table is assumed to be in alphabetical or numeric order and 
therefore if it doe not find an exact match it will go to the nearest option. If 
FALSE is typed, the table does not need to be ordered. In this case, the 
function will only look for an exact match. If one is not found, the error 
value #NA is returned. 
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Using Lookup Tables 

 
 

 
 

In the above example, we have the following lookup function in cell C2.  

=VLOOKUP(A2,Price_Table,2,FALSE) 

VLOOKUP is looking up the value in cell A2.  This value is SP01 

Price_Table is the range of cells VLOOKUP is looking in.  Remember we 
gave the Product List a range name of Price_Table. 

2 is the column VLOOKUP is returning from the Price_Table range.  
Column 2 is the description. 

FALSE tells VLOOKUP to look for an exact match, if it canôt find an exact 
match for SP01, to return the error message #NA, which means not 
available.  Look at the last example in this exercise when we ask 
VLOOKUP to return the value for SP10.  The list we are looking up in 
does not have an SP10 so in this example, because we set the last 
argument to false Excel returned the error message #NA.  Had we 
ignored this last argument Excel would have returned the nearest match 
to SP10, which is SP09, Chocolate Gateaux.  
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MATCH 

Use MATCH instead of one of the LOOKUP functions when you need the 
position of an item in a range instead of the item itself.  MATCH returns 
the relative position of an item in a range. 

MATCH(lookup_value,lookup range,match_type) 

Lookup_value    is the value you use to find the value you want in a 
table. 

Lookup_value is the value you want to match in lookup_array. For 
example, when you look up someone's number in a telephone book, you 
are using the person's name as the lookup value, but the telephone 
number is the value you want. 

Lookup_range    is a range of cells containing possible lookup values. 
Lookup_range must be an range or a range name. 

Match_type    Match_type specifies how Microsoft Excel matches the 
lookup_value with values in lookup_range.  It works the same as FALSE 
is Lookup functions. i.e, If FALSE is typed in the match-type, VLOOKUP 
will find an exact match.  If one is not found, the error value #NA is 
returned.. 

Logical Functions 
The most common logical function is the IF function. However, Excel has 
a number of other logical functions which are useful. The common thread 
that runs through this group is that they test the contents of a cell against 
a logical condition to see if the answer is true or false. 

IF(logical_test,value_if_true,value_if_false) 

At its simplest the IF statement tests to see whether a condition is met; if 
it is met the first value in the argument list is returned otherwise the 
second value is returned. 
The following comparison operators are usable in the logical test: 

= equal to 
> greater than 
< less than 
>= greater than or equal to 
<= less than or equal to 
<> not equal to 

The following example shows an IF function used to examine a bank 
balance to see if it is overdrawn.  If you want the value returned to be 
text, place the text in quote marks. 

 

 A B 

1 Income £900 

2 Expenditure £700 

3 Comment =IF(B1>B2,òIn Creditò,òOverdrawnò) 

The result displayed in cell B3 will be ñIn Creditò as the logical test is true. 

IF functions can contain other formulas as their true or false arguments or 
indeed other IF functions. Up to seven nested IF functions can be nested 
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in one single formula. An example of a nested IF function would be to 
expand the above example to cope with the situation where the Income 
and Expenditure figures are exactly the same. The formula could then 
read: 

=IF(B1>B2,òIn Creditò,IF(B1=B2,òZero Balanceò,òOverdrawnò)) 

AND(logical1,logical2...) 

This function returns the value TRUE if all logical conditions are met and 
FALSE if only some of them are met. For example, the formula 
=AND(2+2=4,3+3=6) would return the value TRUE: the formula 
=AND(2+2=4,2+3=6) would return the value FALSE. 

OR(logical1,logical2...) 

This function is similar to the AND function except that any of the logical 
conditions can be true to return a TRUE value 

NOT(logical1,logical2...) 

This function reverses the values of the logical conditions and returns 
either TRUE or FALSE. In other words the function =NOT(2+2=4) would 
return the value FALSE. 
 

SUMIF(range,criteria,sum_range) 

This function will SUM cells in a range, depending on a given criteria 
 
Range     
is the range of cells that you want evaluated by criteria. 
 
Criteria     
is the criteria in the form of a number, expression, or text that defines 
which cells will be added. For example, criteria can be expressed as 32, 
"32", ">32", or "apples". 
 
Sum_range   
are the actual cells to add if their corresponding cells in range match 
criteria. If sum_range is omitted, the cells in range are both evaluated by 
criteria and added if they match criteria 
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COUNTIF(range,criteria) 

This function Counts the number of cells within a range that meet the 
given criteria. 
 
Range   
 is the range of cells from which you want to count cells. 
 
Criteria    
is the criteria in the form of a number, expression, cell reference, or text 
that defines which cells will be counted. For example, criteria can be 
expressed as 32, "32", ">32", "apples", or B4. 

 

COUNTBLANK(range) 

This function will count the number of blanks cells in a given range. 
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IS Functions 

This section describes the nine worksheet functions used for testing the 
type of a value or reference. 

Each of these functions, referred to collectively as the IS functions, 
checks the type of value and returns TRUE or FALSE depending on the 
outcome. For example, the ISBLANK function returns the logical value 
TRUE if value is a reference to an empty cell; otherwise it returns FALSE. 

Syntax 

ISBLANK(value) 
ISERR(value) 
ISERROR(value) 
ISLOGICAL(value) 
ISNA(value) 
ISNONTEXT(value) 
ISNUMBER(value) 
ISREF(value) 
ISTEXT(value) 
 
Value    
is the value/Cell Ref you want tested. Value can be a blank (empty cell), 
error, logical, text, number, or reference value, or a name referring to any 
of these that you want to test. 
 

Function Returns TRUE if 

ISBLANK 
This function returns either TRUE or FALSE.  
If the cell is empty the answer returned is 
TRUE.. 

ISERR 
Returns TRUE if the cell contains an error 
value value except #N/A. 

ISERROR 
Returns TRUE if any error value (#N/A, 
#VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, 
or #NULL!). 

ISLOGICAL Returns TRUE if cell contains a logical value. 

ISNA 
Returns TRUE if cell contains #N/A (value not 
available) error value. 

ISNONTEXT 
Returns TRUE if cell contains any item that is 
not text. (Note that this function returns TRUE 
if value refers to a blank cell.) 

ISNUMBER Returns TRUE if cell contains a number. 

ISREF Returns TRUE if cell contains a reference. 

ISTEXT Returns TRUE if cell contains text. 
 
 
Remarks  
The value arguments of the IS functions are not converted. For example, 
in most other functions where a number is required, the text value "19" is 
converted to the number 19. However, in the formula ISNUMBER("19"), 
"19" is not converted from a text value, and the ISNUMBER function 
returns FALSE.  
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The IS functions are useful in formulas for testing the outcome of a 
calculation. When combined with the IF function, they provide a method 
for locating errors in formulas.  
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Using Excels Database Features 

 
Excel is a great program for typing managing lists.  Lists can be sorted, 
filtered and subtotalled.   

A database in Excel can be any list provided that the list conforms to two 
clear rules: 

 Every column must have a unique column heading to act as the field 
name. 

 There must be no blank rows or columns within the list otherwise Excel 
will not recognise the list as a single database. 

The data in the following illustration is organised into a list, with column 
headings that define fields and rows that contain records.  A field is a 
specific piece of information in your list of data, such as FirstName, 
LastName, Salary.  A record contains all information about a specific item 
in your list.   

 

 
Whenever you have a database of people, places, or products you need 
a way to filter out everything except the specific information that you need 
at the moment.  You also need to be able to sort the data by specific 
criteria. Excel provides two useful tools for locating specific information in 
a list: filtering and sorting.  With these tools, you can easily sort and filter 
the data in your worksheet. 
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AutoFilter 

Filtering Lists to see only the data you need 

When you work with a database, you need to be able to find information 
quickly.  If you need to find all of the employees working in the Accounts 
Department you don't want to look through the whole list and pick out the 
names manually.  You can use the field names in your database to filter 
your data automatically to show only the records you need. 

When you filter a list automatically you can select any cell and the entire 
list around the cell is selected.  Then you filter the data, using field names 
to show only the records you need.  When you have finished filtering 
data, you turn off automatic filtering. 

Filtering your data 

1. Select any cell within your database. 

2. From the Data menu choose Filter and then choose AutoFilter. 
 
The range adjacent to your selected cell is assumed to be the database 
you want to filter.  Filtering arrow buttons appear next to your column 
labels. 

3. Click the filter arrow next to the field you wish to filter.  A list of criteria 
drops down showing the options that you can choose from.  
 
There are four choices that always appear in your list of criteria, The All, 
Custom, Blanks, and NonBlanks options let you show all of the records, 
only records that meet custom criteria, all blank records, or all records 
that contain information.  In addition to these four choices any other word, 
code or number that appears in the column you select for filtering will 
appear once in the criteria list. 

4. Select any one of the standard choices or the choices from your data to 
be the criterion for filtering your data. 

5. When you select an item in the criteria list, all of the other data is filtered 
out of your worksheet.  The other records still exist, but they are hidden 
for the moment. 

Restoring your data 

When you have finished filtering your data you will want to restore your 
database to show all of the records. 

To do this: 

From the Data menu choose Filter and then choose Show All. 
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Finding Data Using Custom Filters 

Although you can usually find the information you need by selecting a 
single item from a filter list, sometimes you need to find records that 
match a custom set of criteria.  If you need to find every person in your 
list who was born on or after 1st April 1970, for example, you can select 
Custom from the Date of Birth filter list and then place ">= 1/4/70" in the 
Custom AutoFilter dialog box.  You use operators such as an equal sign 
(=), greater than sign (>), and less than sign (<) to determine your custom 
criteria. 

To use a custom filter: 

1. Select any cell within your database. 

2. From the Data menu choose Filter and then choose AutoFilter. 
 
The range adjacent to your selected cell is assumed to be the database 
you want to filter.  Filtering arrow buttons appear next to your column 
labels. 

3. Click the filter arrow to the right of the field you wish to filter and then 
select Custom.  The Custom AutoFilter dialog box opens.  To show all 
members who were born on or after 1st April 1970, in the Date of Birth 
area make sure that ">=" is selected, and then type in 1/04/70 in the 
criteria box, and then choose OK.  Your data is filtered to show only 
members born on or after 1st April 1970. 
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Effect of AutoFilter on other Excel commands 

When you have the filter mode turned on, some commands work 
differently from normal. The following table summarises the commands 
affected. 
 

AutoFill feature Enters the value of the active cell in 
visible cells only 

AutoSum feature Calculates the sum of visible cells only. 
When the filter is changed or removed the 
total changes accordingly. 

Edit|Delete Deletes only visible rows. 

Format, Cells 
Edit, Clear  
Edit, Copy 
File, Print 
Data, Sort 
Data, Subtotals 

 
Acts on the visible cells only 

Printing a Filtered list 

When you print a filtered list Excel only prints the displayed data. 

Copying a filtered list 

When you copy and paste a filtered list Excel copies the visible cells only.  
This is really useful if you want to extract data and place it in another 
worksheet or workbook. 

Charting a filtered list 

When you chart filtered data Excel charts the visible cells only.  However 
if you subsequently need to hide columns or row that you do not want to 
chart you must proceed as follows: 

1. Hide rows and columns that you do not wish to chart. 

2. Select the data you wish to chart. 

3. Choose Edit, Go to, Special, Visible cells only 

4. Proceed as normal to produce your chart. 
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Sorting Data 

When you want to display or print your list of records in a particular order, 
you need to sort your data.  Sorting works somewhat like filtering - you 
select the range that you want to sort, and then you use names to define 
how you want to sort your data.  You can sort your data by any field name 
in the database.  The field name or criteria that you use to sort by is 
referred to as a sort key.  To sort a range, you can select any cell within 
the range, and then use the Sort command.  When you choose the Sort 
command the range around the active cell is automatically selected for 
sorting. 

The following example shows how to sort the membership database first 
by LastName and then by FirstName. 

To sort a database: 

1. Select any cell within your database. 

2. From the Data menu choose Sort.  The sort dialog box opens. 

3. In the Sort By area, click the down arrow, and then select LastName from 
the list. 

4. In the Then By box, click the down arrow and then select FirstName from 
the list. 

5. Make sure that the last Then By box is blank and then choose OK. 
 
The list now sorts alphabetically by LastName, when the LastName 
matches it is then sorted by FirstName. 
 

 
 
Note: Unlike filtering, sorting your database moves the rows to new 
positions.  If you do not want to rearrange your data, use the Undo Sort 
command from the Edit menu to restore the database to its original order. 
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The Data Form 
 
The Data Form is yet another means of entering criteria and displaying 
only those database records that match them. However, the Data Form 
can also be used to enter new records into a database and present the 
records in a nicer format. 

 

To use the Data Form, first ensure that your active cell is located 
somewhere within a database area. Then choose Data|Form from the 
main menu. You will see a dialog box similar to the following: 

To the right of the text boxes is a scroll bar that can be used to move 
through the records one by one. 

To enter search criteria, click on the Criteria button. The data in the text 
boxes will be cleared out and you can then enter you criteria, using 
wildcards and comparison operators as required. When you click on the 
Find Next button, the data form will display the first record that matches 
your criteria. By using the Find Next or Find Previous buttons you can 
move forwards or backwards through the records that match your criteria. 
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Producing Subtotals 
 
Excel provides a very quick and easy way to produce subtotals that 
summarise different parts of your database. Subtotals would normally be 
added to a database that has already been sorted. 

To add subtotals to your database, first carry out the sorting that you 
require and then select Data|Subtotals from the main menu. You will now 
see the following dialog box: 
 

 

The first item you must specify is what will actually cause the subtotals to 
be calculated. This is done by using the drop-down list At Each Change 
In. When you click on the drop-down arrow, the list will display the fields 
contained in your database area. Select the one you require and press 
the Tab key. 

You can now specify the type of calculation that will be undertaken. 
Normally you would accept the default (Sum) which will provide you with 
a subtotal. However, if you click on the drop-down arrow, you will be able 
to choose from other items such as Average, Count, Product, etc. 

Having made your selection, the next step is to move on to the Add 
Subtotal to: list box. In this box you can select the fields in your 
database that will be sub-totalled. You do this by clicking on the required 
fields and thereby placing a cross in the check box. 

You can now use the three check boxes in the bottom left corner of the 
dialog box to set the last few options. It is normally advisable to have the 
Replace Current Subtotals box checked so that your worksheet always 
presents the most recent data. 

When you click on the OK button or press Enter you will be returned back 
to the worksheet and subtotals will have been added to the database 
area. You will also see that Outlining has been applied automatically. You 
can now display either more or less detail on the worksheet to meet your 
requirements. 

To remove subtotals from the worksheet select Data|Subtotals from the 
main menu and then click on the Remove All button on the dialog box. 
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Using Pivot Tables 

Introduction 

Pivot Tables provide a flexible way of analysing and presenting large 
amounts of data in lists and tables. Instead of viewing a long list of data in 
a conventional format of columns and rows, you are able to determine 
exactly how it is organised and presented. The source data for a Pivot 
Table can be either a Microsoft Excel worksheet or another program. 

Although the data in the Pivot Table looks like any other worksheet data, 
you cannot directly enter or change it. The Pivot Table is linked to the 
source data and the values in the cells are read-only. You can however 
change the formatting of the Pivot Table and use them for charting, etc. 
 

Preparing Data for a Pivot Table 
Before using the PivotTable and PivotChart Wizard to create a PivotTable 
report, here are a few important things to look for in your source data: 

 The first row must have a heading for each column. The wizard will use 
these column headings as names for the fields (its word for data 
groupings) that you can drag and drop onto the PivotTable layout area.  

 There should be no empty rows or columns within the range of data used 
for the report. For example, blank rows used to separate one block of 
data from another should be removed.  

 Each column should contain only one kind of datað for example, include 
text in one column and numeric values in a separate column.  

 Excel automatically creates subtotals and grand totals in a PivotTable 
report. If the source data contains automatic subtotals and grand totals 
created with the Subtotals command on the Data menu, use that 
command to remove them before you create the report.  
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Creating a Pivot Table 

A Pivot Table is created with the help of the PivotTable Wizard. 

First select Data|PivotTable and Pivot Chart Report from the main menu. 
This starts the Wizard which has three steps. As with all Wizards, the 
buttons along the bottom of the dialog box allow you to move forwards 
and backwards through the steps. 

In Step 1 you must specify the type of source data; you will normally 
choose Microsoft Excel List or Database.  

Specify whether you wish to create a Pivot Table or a Pivot Chart 

 

Click on the Next button to move on to step 2. 

In Step 2 you must specify the source data area.  

 

The Wizard may well already have selected the correct range; either 
accept this or drag over the correct area (remember to include the column 
headings in your selection)  on the worksheet and then click on the Next 
button. 
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Step 3 allows you to choose the location and layout of the Pivot Table: 

The Layout dialog box looks like the following, you are able to choose 
the fields that you want shown in the Pivot Table. Basically, this step 
allows you to define the layout of the Pivot Table. 

 
 

You must first determine which fields contain the data you wish to 
summarise and then drag the corresponding grey box into the DATA area 
of the dialog box. If you choose a numeric field in this area, the Wizard 
will automatically sum the data; if you choose a non-numeric field the 
Wizard will opt to count it. 

The next step is to determine how you want the data arranged. Drag the 
grey buttons for the chosen fields either on to the Column or Row 
heading areas. If you want to display a field as a heading on separate 
pages, drag its button to the PAGE area of the dialog - this effectively 
allows you to create a third dimension to your data. 

The Options button allows you to choose from several options which 
determine whether you want to see grand totals, how you want the data 
saved and whether you want an AutoFormat applied. 
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Finally you can specify the location of the Pivot Table. You can put it in 
any worksheet and in any workbook. Simply enter the upper-left corner of 
the destination area in the box labelled Pivot Table Starting Cell. 

When you have completed all the steps, click on the Finish button. 
Microsoft Excel will now create your Pivot Table and once it has finished 
both the table and the Pivot Table toolbar, and the Pivot Table field list 
will be displayed on your screen. 

Updating and Amending a Pivot Table 

When you change the data in the source list, the Pivot Table itself does 
not automatically update. The way to change the data in the Pivot Table 
so that is picks up the source data is to Refresh it. 

To refresh the Pivot Table, first select any cell within the table. Then click 
on the Refresh Data toolbar button or select Data|Refresh Data from the 
main menu. Any changes will now be reflected in your Pivot Table. If, 
however, you have added data to the source worksheet which you want 
in your Pivot Table, you will need to go through step 2 of the Wizard 
again to select a different data source area. 

Pivot Table Toolbar 

You will probably find the Pivot Table toolbar invaluable whilst creating 
your Pivot Table.  If you accidentally switch it off, switch it on again by 
choosing Pivot Table from the View, Toolbars menu.  
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Pivot Table Field List 

The Pivot Table Field List is new in Excel XP.  When you have included 
all the field you want in the Pivot Table, it is often easier to switch the field 
list off.  Switch it on again by clicking the Show Field List button on the 
Pivot Table toolbar.  We would recommend that you do keep the Pivot 
Table toolbar on when you are working with your Pivot Table.  
 

 

Adding New Rows, Columns or Pages 

You can change the structure of your Pivot Table after it has been 
created by adding new rows or columns. This will increase the level of 
detail in your Pivot Table. You can also add additional fields to the Page 
area of the Pivot Table; this has the effect of restricting the level of detail 
shown in the Pivot Table. 
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To add a new row, column or page field first select a cell in the Pivot 
Table and then drag buttons on and off the Pivot Table Field list. 














































